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Advanced Price Book Module

The Advanced Price Book Module (APBM) provides interactive access to price information when entering
customer orders and extends the order entry functions currently available in the system. The Advanced
Price Book Module is used to define price books, items contained in each price book, and the assignment
of price books to customers. With interactive access to relevant price information, you can provide more
effective customer service during order entry.

You can define and assign price books appropriate to your marketing strategy. For example, define price
book contents to reflect items in a product family and assign a price book to customers based on customer
groupings, geographic regions, or market segments.

The key functions of the Advanced Price Book Module focus on maintenance of price book information,
pricing structures, contents and assignment to customers, and accessing the relevant price information at
the time of order entry.

Module Prerequisites
The Advanced Price Book Module has the following prerequisites:
+ SYSM (System Control)
* INVM (Inventory Control)
*  MOMM (Manufacturing Order Management)
*  CUSM (Order Entry)

The following modules are not prerequisite modules, but each greatly enhances the functionality of the
APBM Module:

«  MCMM (Multi-Currency Management)

» Foreign currency price books are available when the MCMM Module is installed.
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Setting Up the Advanced Price Book Module

Setting Up the Advanced Price Book Module provides an overview of how to implement the
module. It covers:

guidelines to consider before you implement the module
how to prepare your data for loading
suggested procedures for loading your data

suggestions for using the module

Before You Implement the Module

The Advanced Price Book Module extends the functionality of the order entry process by
maintaining information regarding price books and price book availability. Price book information is
accessible during the order entry process.

Guideline Review

Before you implement the Advanced Price Book Module, review these guidelines on customer,
item and pricing information.

Each customer must have a unique customer identifier, and the information about each
customer should be accurate.

Procedures and responsibility should be established for creating price books, maintaining item
prices and associating authorized price books with customers.

An implementation plan should be developed. This plan should include a cutover date for the
loading of information about prices and customer-price book relationships.

Preparing Your Data for Loading

Iltems must be defined on the ltem Master, and customers must be defined on the Customer
Master, in order to use item and customer information in the Advanced Price Book Module.

Suggestions for preparing and loading item information are described in the Setting Up the
Module section of the Inventory Control and Order Entry User Guides.

Suggestions for preparing and loading customer information are described in the Setting Up
the Module section of the Order Entry and Accounts Receivable User Guides.

Suggestions for preparing and loading currency code information are described in the Setting
Up the Module section of the Multi-Currency Management User Guide.

The following supplemental suggestions are tailored to the use of the Advanced Price Book
Module.

Item Information

Review Item Master information used by the Advanced Price Book Module.

Advanced Price Book

Check the completeness and accuracy of item numbers and descriptions on the ITMB (ltem
Master) screen.

Review the accuracy of inventory costs on the ITMC (Item/Work Center Cost Data) screen.
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+ Review the accuracy of item standard prices on the ITPB (ltem Price Book) screen.

Customer Information

Check the completeness and accuracy of customer ids and names on the CUST or CUID
(Customer Master) screen, and the customer addresses and financial information on the
Customer Name/Address Detail and Customer Financial Detail screens.

Price Books

Identify the price books you use. A price book is a list of items, the prices of which are available to
certain customers over a given period of time. Price book examples under different pricing
strategies are as follows:

* Regional Pricing. Northeast, Southeast, Midwest, West and International.
* Customer Type. Wholesaler, Distributor, National Account and OEM.

+ Contract Pricing. Specific customer price, customer buying group and blanket purchase
order.

*  Product Line. Price lists by major product line.

* Foreign Currency. Price lists by country or geographical region in a specific base currency.

Price Book Contents

Identify items to be included in each price book. The method used varies based on your pricing
strategy. For example, under a regional pricing strategy, all salable items may be included in each
price book. Under a contract pricing method, only those items covered under each contract are
included in each price book.

Price Book Price Breaks and Expedite Fees

Identify customer prices based on quantity breakpoints. Determine if expedite fees should be
included when the order is shipped within the standard lead time. Pricing methods for both quantity
breakpoints and expedite fees can be based on:

* absolute price
* amultiple of unit price
+ amultiple of unit cost

The PBCF — Price Book Configuration screen is used to indicate price book display, selection,
preference usage and effectivity basis. Review the Number of Decimal Places for Prices field.
Price book values are truncated to this number of decimal positions, not rounded. You can change
the default price book type, if desired.

Customer-Price Book Relationships

Once price books are created, you then associate them with the appropriate customers. This
relationship allows multiple customers to be associated with each price book. Up to 36 price books
can be associated with each customer. When specifying the customer-price book relationship, you
assign a one-character code to identify the relationship in the Customer Pref field. This one-
character code can then be used to select a price book on the COMT (Customer Order) screen
during the order entry process.

Data Entry Alternatives
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Data sets can be copied and updated to reduce data entry time and ensure accuracy. The
following screens/tasks provide a copy function you can use to enter similar data:

Data Module Screen/Task Alternate
items included in each APBM Price Book Contents CPBK
price book
Loading Your Data

Using Data Import Macros
Transactions are available for creating or manipulating price book information. Refer to the Data
Import Module manual for more information.

Loading Data into the Advanced Price Book Module

Once your data has been prepared for entry, use this section to load your data into the Advanced
Price Book module.

A validation tool is identified for each screen or task listed in this section. Use the validation tool
to double-check the accuracy of the data you have entered. Validation tools include:

+ Screen reports. Create these reports by choosing Print from the File menu. For more
information, see "Screen Reports" in the Fourth Shift Basics manual.

* Print screens. When other report options are not available, you can capture an image of your
screen and use it to validate your data entry. For more information, see "Using the Print
Screen Key" in the Fourth Shift Basics manual.

+ SQL Enterprise Manager. For SQL, use the SQL Enterprise Manager to validate DTS
packages.

Other validation tools, such as batch processes and data extracts, may also be listed.

1. Configure the Module

The PBCF (Advanced Price Book Configuration) screen is accessed from the Advanced Price

Book Menu.

Screen/Task Module Description Validation Tool
Advanced Price Book Configura- | APBM price book display, selection, print screen
tion window from APBM preference usage and effectivity

basis
Function Code Maintenance SYSM security on each screen print screen
FCMT
2. Identify Price Books

Screen/Task Module Description Validation Tool

PBMT APBM price books screen report +
DVUD

Advanced Price Book 7
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You must identify the type of price book:
* ltem
+ Catalog

¢ Customer ltem

3. Enter Price Book Contents

Screen/Task Module Description Validation Tool
Default Breakpoint Settings win- | APBM default pricing methods print screen
dow from Price Book Contents or
CPBK
Price Book Contents APBM items included in each price book | n/a
Quantity Breakpoints and Price APBM pricing methods on a price book- | print screen
Formulas window from Price by-price book basis
Book Contents
Price Book Contents APBM price book print screen report +
DVUD

4. Define Customer/Price Book Relationships

Screen/Task Module Description Validation Tool
CuUPB APBM customers/price book associations screen report + DVUD
CUID CUSM customers/price book associations screen report + DVUD

Suggestions for Using the Module

The ways in which the Advanced Price Book Module are used vary from company to company.
The following guidelines may be helpful for using the module in your company.
Updating Customer and Item Information

Before entering price book information, define customers on the Customer Master and items on
the Item Master. Then extract the data for use in the Advanced Price Book Module.

* Use the CUID or CUST (Customer Master) screen, and associated Customer Name/Address
Detail and Customer Financial Detail screens, to enter information about new customers.

» Use the ITMB (Iltem Master), ltem Master Detail, Item Master Planning Detail and ITMC (ltem/
Work Center Cost Data) screens to enter information about new items.
Using the Field Browse Feature

The Advanced Price Book Module provides a Price Book, Item and Customer Field Browse to
assist data entry when you cannot recall an identifier or can only remember a partial identifier.

+ The Price Book Field Browse feature can be used in the Copy from Price Book, Copy to
Price Book and Price Book Name fields.
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« The Item Field Browse feature can be used in the Item field.
« The Customer Field Browse feature can be used in the Cust Id field.

For more information, see "Field Browse" in the Fourth Shift Basics manual.

Using the Window Browse Feature

The Advanced Price Book Module provides a Customer, Item and Price Book Window Browse
to assist data entry when you cannot recall an identifier or can only remember a partial identifier.
The Window Browse feature can be used in the following fields:

*+ Custlid

+ Copy from Price Book

+ Copy to Price Book

+ ltem

*  Price Book Name

+ Starting Customer Id

« Starting Item

+ Starting Price Book Name

Using the Multi-Currency Feature

When the Multi-Currency Management (MCMM) Module is installed, it extends the functionality of
this module by allowing you to enter multi-currency transactions.

Foreign currency price books can be defined for use with each foreign currency as needed. Price
books should be defined for use with foreign customers or local customers not both. The currency
code of the customer is used to determine whether a calculation is needed from the unit price
defined in the price books.

* For local customers (Curr Code = 00000), the price book values are used as defined in the
price book. No calculation is needed.

For an example of customer order processing using foreign currency price books in a multi-
currency environment, see "Price Books Using Multiple Currencies" in the Multi-Currency
Management manual.

Creating Pricing Information

Add items to price books using F9 (Price Book Contents) from PBMT (Price Book Master) or
CPBK (Copy Price Book) screen.

» If items are added from the ltem Master, use F9 (Price Book Contents) from the PBMT screen.

+ If all the items from an existing price book are to be added to the new price book, use the
CPBK screen.

Use the related Default Breakpoint Settings window to establish pricing methods for each quantity
breakpoint. Pricing methods consist of a unit price formula and an expedite fee formula. The
purpose of the expedite fee is to allow the automatic addition of a surcharge when items are
ordered without allowance for the proper lead time.

Default breakpoint settings are established for each price book.
Use the related Quantity Breakpoints and Price Formulas window to change pricing methods on a
price book-by-price book basis after items are added to a price book.
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Maintaining Customer-Price Book Relationships

Use the Customer Pref field to identify the customer-price book relationship. One customer can
have up to 36 price book relationships identified.

The Customer Pref field is an audit trail of the price book source. When a price is selected from
one of the price books available to the customer, the Customer Pref character is automatically
entered into the ST (source type) field on a customer order line item.

Use the Customer Sp field to indicate a price book is a special promotion. The Special field on
the Available Pricing window corresponds to the Customer Sp field. The Available Pricing window
is opened during the order entry process.

The Pending field is displayed when the price book effectivity date falls within the range specified
on the Advanced Price Book Configuration window.

Use the Disable fields on the Advanced Price Book Configuration window to ignore the effectivity
dates assigned to a customer/price book relationship.

Placing Customer Orders

The Advanced Price Book Module emulates a manual price entry on the COMT (Customer Order)
or CPMT (Custom Product Maintenance) screen. Manual price entries are not adjusted by the
surcharge/discount factor assigned to the customer on the Customer Master or on the Customer
Order Header Detail screen. Manual price entries are identified by Price Source = M on the
Standard Product Detail or Custom Product Detail screen.

When creating a customer order, you can access price book information to determine which price
to use. Press ALT+F8 when the cursor is positioned in the Unit Price field to open the Available
Pricing and Quantity Breaks and Expedite Fees windows.

» The Available Pricing window identifies the price books that contain the ordered item and are
associated with, and in effect for, the customer. Use the Available Pricing window to select a
price book.

* The Quantity Breaks and Expedite Fees window displays price information for the ordered
item and selected price book. You can select the suggested unit price or choose a price
related to a different quantity breakpoint.

Several features on both windows are controlled by parameters defined on the PBCF (Advanced
Price Book Configuration) screen.

* Use the Pending Price Books Displayable Within field to indicate the number of days in
advance of a price book's effectivity the price book should be displayed on the Available
Pricing window.

* Use the Pending Price Books Selectable Within field to indicate the number of days in
advance of a price book's effectivity the price book is available during the order entry process.

+ Use the Expedite Fees May Be De-Selected by User field to indicate whether order entry
personnel may optionally override the calculated expedite fees.

If expedite fees can be overridden, you are prompted to:
- include expedite fee
- exclude expedite fee

- cancel price selection
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* Use the Price May Be Selected from Any Quantity Break field to indicate whether order
entry personnel can select from any quantity break level, rather than just the most appropriate
level, based on order quantity.

» Use the Disable fields on the Advanced Price Book Configuration window to ignore the
effectivity dates assigned to a customer/price book relationship.

* Use the Match Price Book Preference to ST Field on COMT Screen field to indicate
whether the ST (source type) field on a line item should identify the price book to be selected.

* Use the Base Price Book Effectivity on Current, Ship or Delivery Date field to indicate the
basis for price book effectivity.

Creating Catalog Item Price Books

Price books can be defined using either the standard Item Master identifier or using catalog item
identifiers defined on the CCAT (Customer Catalog) screen. The same price book options are
available for both types of price books.

Creating a catalog item price book consists of the following:

* Use the PBMT (Price Book Master) screen to enter a new price book. Enter the Price Book
Name and tab to the price book type field at the end of the line. Enter Price Book Type = C to
identify this as a catalog item price book.

You can define the default price book type as catalog items using the Advanced Price Book
Configuration window, as an option.

* Use Price Book Contents (F9 from PBMT) screen to add items to the price book. The item
identifiers must be the catalog item identifiers entered on the CCAT screen. Enter the
appropriate quantity breakpoints information as needed.

* Use CIMT (Customer Item Maintenance) to enter customer item number information.

* Use the CUPB (Customers Using Price Book) screen to assign customers to use the new
price book.

* Use the COMT (Customer Order) screen to enter a customer order. Use LS = B on the COMT
screen to identify catalog item identifier usage. The Available Pricing window displays catalog
item pricing information.

System Administration

The System Administration manual outlines the tasks involved in maintaining Fourth Shift. The
Advanced Price Book Module includes special considerations in the areas of security and periodic
tasks.

Security

Use the FCMT (Function Code Maintenance) screen to set up screen security for the following
screens:

* CPBK (Copy Price Book)

* CUPB (Customers Using Price Book)

*  CUPI (Customers Using Price Book - Inquiry)
»  PBCEF (Price Book Configuration)

* PBII (Price Book Usage By Item)

Advanced Price Book 11



Fourth Shift Release 8.00 Setting Up the Advanced Price Book Module

*  PBMI (Price Book Master Inquiry)
*  PBMT (Price Book Master)

It is generally advisable to limit screen access to only those personnel responsible for maintaining
an accurate database.
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PBMT — Price Book Master

Use the Price Book Master screen to define the price book name, description, and price book effectivity
dates. Default breakpoint settings are defined for each price book. Each price book can contain unique
settings that will be applied to all items added to that price book in the future.

Two versions of this screen are available: one for maintenance and one for inquiry use only. The
information displayed is the same, only the ability to change the information changes depending on the
screen you access.

* The PBMT (Price Book Master) screen allows you to view and update price books.
« The PBMI (Price Book Master Inquiry) screen only allows you to view this information.
See "Entry and Inquiry Screens" under "Screen Types" in the Using Fourth Shift section of the Fourth
Shift Basics manual for more information.
Transportation Shortcuts

You can use shortcut keys or transport buttons to go to the following related screens.

Destination Shortcut Key(s)
Price Book Breakpoints F8
Price Book Contents F9
Iltem Quantity Breakpoint F9 from Price Book Contents
CUPB/CUPI (Customers Using Price Book) F10

Additional Information

Shortcut
Window Available From Key(s)
Report Destination Any location on the screen F7 or Print from
Toolbar

Browse Windows

You can open browse windows by choosing Browse/Detail from the Tools menu in the following

fields:

Browse From Fields

Price Book Name Starting Price Book Name

For more information, see "Selecting from a Browse List" in the Fourth Shift Basics manual.

Advanced Price Book
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Reports

Price Book Master
Lists price books.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

SQL Server Reporting
SQL Server Reporting Services reports are available:

+ APBCUPB.RDL
+ APBPPCT.RDL
+ APBPBIL.LRDL

+ APBPBMT.RDL

Report Template

For more information on report templates, see "Reporting for SQL Server Systems" in the System
Help topics.

Fields

Description

Price Book Description identifies the price book in terms of its characteristics. When space is
limited, a partial description is displayed.

Where Used: Available Pricing; CUPB; CUPI; PBII; PBMI; PBMT; Price Book Assignment;
Price Book Usage, Price Book Contents

Function

Function codes are four-character abbreviations for screen names. Each screen has a unique
code used for identification and transportation. For example, ITMB identifies the Item Master
screen. Entry is 4 alphanumeric characters.

Where Used: screens and reports

PB Type

Price Book Type indicates which type of items are included in the price book.

Q = Customer items
C = Catalog items
| = Item Master items

Where Used: PBMT

Price Book In Effectivity

Price Book In Effectivity Date is the date the price book becomes effective.
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Where Used: Available Pricing; CUPB; CUPI; Price Book Contents; PBIl; PBMI; PBMT

Price Book Name

Price Book Name is the unique identifier for a price book. Entry is any alphanumeric
combination of up to 15 characters.

Where Used: Available Pricing; CUPB; CUPI; Price Book Contents; PBIl; PBMI; PBMT;
Price Book Assignment; Price Book Usage

Price Book Out Effectivity
Price Book Out Effectivity Date is the last date that the price book is effective.

Where Used: Available Pricing; CUPB; CUPI; PBCI; Price Book Contents; PBIl; PBMI;
PBMT

Sort Sequence
Sort Sequence indicates how information should be displayed. Sort Sequences are:

P = Price book hame

O = Out effectivity of price book
I = In effectivity of price book

D = Description of price book

Where Used: PBMI; PBMT

Starting Price Book Name

The Starting field is used to request a list where the specified information appears first on the
list. Starting entries may consist of a partial entry and if the entry is not in the list, the next
highest entry appears first on the list. The Starting field can include one or more field
combinations, each with its own entry requirements.

Where Used: A/P 1099 Distribution; A/P Payment Application Detail; A/P Payment Void
Detail; A/P Received Item List; A/P Receiving Detail; A/R Payment Application Detail; APAH;
APDS; APEX; APID; APIE; APII; APIR; APIV; APPA; APPD; APPI; APPO; APTX; ARAH;
ARCD; AREX; ARIC; ARIH; ARPD; ARPH; ARSR; BAMT; Bank Payment Approval; BILI,
BILL; BKMT; Browse Setup (customer); Browse Setup (item); Browse Setup (vendor); CACF;
CCAN; CCAT; CCEX; CCMT; CIMT; CMCF; CMTA; CMTI; CNFA; COAN; COMI; COMT;
Contract Item Detail/Pricing; CORV; CPMT; CUID; CUIl; CUSI; CUST; FCMT; FCST; G/L
Account Group/No List; G/L Account No List; G/L Batch Detail; G/L Journal Entry List; G/L
Master Account Recap; G/L Org No List; G/L Org/Acct Group List; G/L Organization Group/No
List; G/L Report List; G/L Source Code List; GLAG; GLAV; GLBD; GLCA; GLCI; GLDQ;
GLEX; GLGQ; GLJD; GLJE; GLJI; GLJP; GLJR; GLMA; Global Extended Text Selection;
GLOS; GLRD; GLRL; GLSC; GLSI; GLSS; ITBI; ITCB; Item Master; Item Shortages; ITMB,;
ITMI; ITPB; ITPI; IVCO; IVIA; IVIE; IVII; IVRV; LMMT; Location Selection Setup; MCST;
MOAN; MOMI; MOMT; MORI; MORV; MPED; MPIT; MSMT; NMTA; OPSL; Orders on
Shipment; ORST; Packaging Detail; PASS; PBCI; Price Book Contents; PBMI; PBMT; PCMT;
PCST; PICI; PICK; POAN; POAS; POCI; POCT; POMI; POMT; PORI; PORV; REDI; RTMT;
RVED; SBOL; Selection Setup; Serial Number List; Serial Numbers Shipped; SHIP;
Shipments by Line Item; SHPI; SSII; STAD; SUND; SUNR; SUPD; SUPR; TEXT; TXTA; VAT
Summary (APSM Module); VATT; VEDI; VEID; VEND; VENI; Workcenter Master
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Customer Selection Criteria Fields

From

From identifies the beginning of the range for the report or process. Entry length matches the
range option.

Thru

Thru identifies the ending or target for the specified process.

Advanced Price Book 16
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Price Book Breakpoints

The Default Breakpoint Settings window is opened from by pressing F8 at the PBMT (Price Book
Master) screen. The Default Breakpoint Settings window is used to view and maintain the default
price information used when adding an item to a price book. You can define an unlimited number
of quantity breakpoints and specify the unit price formula and the expedite fee formula for each
quantity breakpoint.

There is always one quantity breakpoint. Before establishing your own quantity breakpoints, a

quantity breakpoint of 1 through 9999999999 is listed. As you add, change and delete quantity

breakpoints, the From field reflects the changes. The last Thru field remains 9999999999.
Transportation Shortcuts

You can use shortcut keys or transport buttons to go to the following related screens.

Destination Shortcut Key(s)

Returns to PBMT or Price Book Contents ESC

Fields
Quantity Breakpoint From

From Quantity Breakpoint indicates the lowest value in the breakpoint range and is
automatically assigned by the system based on the Thru Quantity Breakpoint value of the
previous breakpoint range.

Quantity Breakpoint Thru

Thru Quantity Breakpoint indicates the highest value in the breakpoint range. Entry is up to
10 numbers.

Unit Price Formula

Unit Price Formula consists of a Price Basis and the related Price/Multiple, as shown in the
following possible combinations.

Price Basis Price/Multiple

A = Absolute Absolute price entered as UNIT PRICE

P = List Price Multiple of UNIT PRICE

C = Std Cost Multiple of total roll cost, Cost Type=0

0 = Std Cost Multiple of total roll cost, Cost Type=0

1 = Cost Data Multiple of total roll cost, Cost Type=1

3 = Cost Data Multiple of total roll cost, Cost Type=3

4 = Cost Data Multiple of total roll cost, Cost Type=4

5 = Cost Data Multiple of total roll cost, Cost Type=5

6 = Cost Data Multiple of total roll cost, Cost Type=6
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Price Basis Price/Multiple

7 = Cost Data Multiple of total roll cost, Cost Type=7

8 = Cost Data Multiple of total roll cost, Cost Type=8

9 = Cost Data Multiple of total roll cost, Cost Type=9

Entry in the Price/Multiple field can be any numeric value between 0 and 10000000 with up to
4 decimal places.

Expedite Fee Formula

Expedite Fee Formula consists of Price Basis and the related Price/Multiple, as shown in
the following possible combinations. Whenever the number of shop days between the current
date and the shipment date is less than or equal to the Lead Time (transportation lead time
days), the Expedite Fees can be incurred.

Price Basis Price/Multiple

A = Absolute Absolute price entered as UNIT PRICE

P = List Price Multiple of UNIT PRICE

C = Std Cost Multiple of total roll cost, Cost Type=0

0 = Std Cost Multiple of total roll cost, Cost Type=0

1 = Cost Data Multiple of total roll cost, Cost Type=1

3 = Cost Data Multiple of total roll cost, Cost Type=3

4 = Cost Data Multiple of total roll cost, Cost Type=4

5 = Cost Data Multiple of total roll cost, Cost Type=5

6 = Cost Data Multiple of total roll cost, Cost Type=6

7 = Cost Data Multiple of total roll cost, Cost Type=7

8 = Cost Data Multiple of total roll cost, Cost Type=8

9 = Cost Data Multiple of total roll cost, Cost Type=9

Entry in the Price/Multiple field can be any numeric value between 0 and 10000000 with up to
4 decimal places.
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Price Book Browser

Use this window to select or search for Price Books that are currently defined. Description and in and out
effectivity dates are also displayed.

For more information on using browse windows, see "Selecting from a Browse List" in the Fourth Shift
Basics manual.

Features

Transportation Shortcuts

You can use shortcut keys to go to the following related screens.

Destination Shortcut Key(s)

Previous screen ESC

Fields
Sorted By Price Book Name

Price Book Name is the unique identifier for a price book. Entry is any alphanumeric
combination of up to 15 characters.

Description

Price Book Description identifies the price book in terms of its characteristics. When space is
limited, a partial description is displayed.

Pb Effectivity In
Price Book In Effectivity Date is the date the price book becomes effective.

Pb Effectivity Out
Price Book Out Effectivity Date is the last date that the price book is effective.
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Price Book Contents

Use the Price Book Contents screen to define the items contained in a price book and to maintain each
item's price information on the associated Quantity Breakpoints and Price Formulas window. Use Data
Import to add or delete groups of items from the price book.

Two versions of this screen are available: one for maintenance and one for inquiry use only. The
information displayed is the same, only the ability to change the information changes depending on the
screen you access.

* F9 from the PBMT (Price Book Master) screen allows you to view and update price books.
«  F9 from the PBMI (Price Book Master Inquiry) screen only allows you to view this information.
See "Entry and Inquiry Screens" under "Screen Types" in the Using Fourth Shift section of the Fourth
Shift Basics manual for more information.
Transportation Shortcuts

You can use shortcut keys or transport buttons to go to the following related screens.

Destination Shortcut Key(s)
Returns to PBMT/PBMI (Price Book Master) F8
ltem Quantity Breakpoint F9
CUPB/CUPI (Customers Using Price Book) F10

Browse Windows

You can open browse windows by choosing Browse/Detail from the Tools menu in the following
fields:

Browse From Fields

Price Book Name Browse Price Book Name

For more information, see "Selecting from a Browse List" in the Fourth Shift Basics manual.

Reports

Price Book Contents (Iltem, UM and Descriptions only)
Lists items contained in a price book showing only the items.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

Report Template
For more information on report templates, see “Reporting for SQL Server Systems” in the System
Help.
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Price Book Contents--Formulas for Unit Price & Expedite Fees
Lists items contained in a price book showing formulas.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

Report Template
For more information on report templates, see “Reporting for SQL Server Systems” in the System
Help.

Price Book Contents--Quantity Breaks & Prices
Lists items contained in a price book showing the quantity breaks and prices.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

Report Template
For more information on report templates, see “Reporting for SQL Server Systems” in the System
Help.

Screen Reference

Using the Default Breakpoint Settings Window

The Default Breakpoint Settings window is opened from by pressing F8 at the PBMT (Price Book
Master) screen. The Default Breakpoint Settings window is used to view and maintain the default
price information used when adding an item to a price book. You can define an unlimited number
of quantity breakpoints and specify the unit price formula and the expedite fee formula for each
quantity breakpoint.

There is always one quantity breakpoint. Before establishing your own quantity breakpoints, a
quantity breakpoint of 1 through 9999999999 is listed. As you add, change and delete quantity
breakpoints, the From field reflects the changes. The last Thru field remains at 9999999999.

Using the Quantity Breakpoints and Price Formulas Window

The Quantity Breakpoints and Price Formulas window is used to view and maintain the price
information for an item in a price book. You can define an unlimited number of quantity breakpoints
and specify the unit price and expedite fee formula for each quantity breakpoint.

There is always one quantity breakpoint. If default quantity breakpoint settings were on when the
item was added to the price book, the Quantity Breakpoints and Price Formulas window lists
quantity breakpoints based on the default settings. If default quantity breakpoint settings were not
used during item addition, a quantity breakpoint of 1 through 9999999999 is listed. As you add,
change and delete quantity breakpoints, the From field reflects the changes. The last Thru field
remains at 9999999999.

Press F9 from an item line to open the window.

Advanced Price Book 21



Fourth Shift Release 8.00 Price Book Contents

Fields
Catalog Item (displays for Catalog Price Book)

Catalog Item is the unique identifier for a catalog item that may be entered on a customer
order. A single item may have many catalog items connected to it. Entry is any alphanumeric
combination of up to 25 characters.

Description (Catalog)

Catalog Item Description identifies the catalog item in terms of its characteristics. Entry is
any alphanumeric combination of up to 70 characters.

Description (Item)

Item Description identifies the item in terms of its characteristics. When space is limited, a
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV;
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill;
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV;
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail;
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP;
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD;
ISVI; ITBI; ITCB; ITCI; ltem + Alternates; Item + Quantity; Item Availability; Iltem Availability +
Quantity; Iltem Browse; Item Browse Detail; Iltem History; Item Lot Trace and Serialization
Detail; Iltem Master; Item Master Detail; Item Master Planning Detail; ltem Responsibility
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report;
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line ltem Details +
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order
Line ltem Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST;
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill;
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging
Detail; Partner ltem Detail; PBCI; Price Book Contents; PBII; PICI; PICK; Picklist Detail;
POAN; POAS; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production;
Purchase Order Line Item Detail; Purchase Order Line ltem Detail (CPMT); Purchase Order
Line ltems; Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI;
QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line ltem;
Shipping Detail; Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report;
SSIl; SSIL; Standard Costs Assigned Results; Standard Product Detail; Summarized Bill;
Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Description

Price Book Description identifies the price book in terms of its characteristics. When space is
limited, a partial description is displayed.

Where Used: Available Pricing; CUPB; CUPI; PBII; PBMI; PBMT; Price Book Assignment;
Price Book Usage, Price Book Contents
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Function

Function codes are four-character abbreviations for screen names. Each screen has a unique
code used for identification and transportation. For example, ITMB identifies the Item Master
screen. Entry is 4 alphanumeric characters.

Where Used: screens and reports

Item Type is used to indicate whether an item is material, reference, tool or resource. You can
enter one of four codes and Item Type can only be changed or added on the Item Master. The
Item Types are:
N = Normal.
The item is material consumed in the manufacture of products.

X = Reference.

The item appears on the bill, but is not consumed in the manufacture of its parent,
such as a drawing.

T =Tool.
A tool is used to manufacture its parent.

R = Resource.

This item is used in the planning process of the manufacture of its parent, such as
labor hours.

Where Used: AVIl; AVIT; Bill of Material Detail; Demand Peg Detail; FCST; IHIR; INVR;
IORD; IPPD; ltem Browse Detail; Item History; Item Lot Trace and Serialization Detail; ltem
Master; Item Master Detail; Item Master Planning Detail; ITHC; ITHR; ITMB; ITMI; Lot Trace;
MPSR; MPSS; MSMT; MUSE; PBCI; Price Book Contents; Picklist Detail; Production; QUOI;
QUOT; SDAB; SDAL; Single-Level Configuration Bill of Material Report; SSII; Supply Peg
Detail; WUSE

Item (displays for Iltem Price Book)

Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an
assembly or finished product. All items are set up using the ITMB screen. Within a product
structure, an item can be a component as well as a parent. Entry is any alphanumeric
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT;
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of
Summarized Bills; COMT; Contract Iltem Detail; Contract ltem Detail/Pricing; Contract
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order;
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report;
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; ltem + Quantity; ltem Availability; Item Availability +
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; ltem Lot Trace and
Serialization Detail; Item Master; ltem Master Detail; Item Master Planning Detail; Iltem
Responsibility Assigned Results; ltem Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI;
Lead Times Assigned Results; LEXP; LHIS; Line ltem Details + ltem; LMSI; LMST; Lot Detail;
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Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT;
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance
Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner ltem
Detail; PBCI; Price Book Contents; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT;
PORI; PORV; POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List;
Pricing Maintenance + ltems/Customers; Pricing Maintenance + Test Order; Production;
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers
Shipped; SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item;
Shipping Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned
Results; Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail;
VDII; VDIT; VDSC; VEIT; Vendor/ltem Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Where Used: CPBK; CUPB; CUPI; PBCI; Price Book Contents; PBMI; PBMT; PBUC; PBUI

MB

Make-Buy Code indicates if a part is normally purchased or manufactured. Make-Buy Code
also directs appropriate action messages to the Buyr (B or S) or PInr (M). Make-Buy Codes
are:
M = Make.
Manufactured in-house.
B = Buy.
Purchased; no parts supplied to vendor.
S = Supplied.
Purchased; parts supplied to vendor.
Where Used: ABCR; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; COMP;
Costed Bill Detail; CSLB; Demand Peg Detail; Engineering; FCST; IHIR; IORD; IPPD; Item
Availability; Item Browse Detail; Item History; Item Lot Trace and Serialization Detail; Iltem
Master; Item Master Detail; Item Master Planning Detail; ltem Responsibility Assigned
Results; Item Shortages; ITHC; ITHR; ITMB; ITMI; Lead Time Analysis; Lead Times Assigned
Results; Lot Size Multiple Detail; Lot Trace; LSDA; LVAL; Material Exposure; Material
Shortages Detail; MBIL; MPSR; MPSS; MSMT; Multi-Level Bill; PBCI; Price Book Contents;
Production; QUOI; QUOT; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill

of Material Report; SSII; Standard Costs Assigned Results; Summarized Bill; Supply Peg
Detail

Price Book In Effectivity
Price Book In Effectivity Date is the date the price book becomes effective.
Where Used: Available Pricing; CUPB; CUPI; PBII; PBMI; PBMT; Price Book Contents

Price Book Name

Price Book Name is the unique identifier for a price book. Entry is any alphanumeric
combination of up to 15 characters.
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Where Used: Available Pricing; CUPB; CUPI; PBII; PBMI; PBMT; Price Book Assignment;
Price Book Usage; Price Book Contents

Price Book Out Effectivity
Price Book Out Effectivity Date is the last date that the price book is effective.
Where Used: Available Pricing; CUPB; CUPI; Price Book Contents; PBIl; PBMI; PBMT

Rev

Revision Level identifies a level of documentation which specifies the item's design. It should
be incremented for each change in the item's design specifications. Entry is any alphanumeric
combination of up to 2 characters.

Where Used: AVIl; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Costed Bill Detail;
Demand Peg Detail; Engineering; FCST; ICCR; IORD; IPPD; Item Browse Detail; Item
History; ltem Lot Trace and Serialization Detail; Item Master; Item Master Detail; ltem Master
Planning Detail; ITMB; ITMI; LMSI; LMST; Lot Detail; Lot Trace; MBIL; MPSR; MPSS; MSMT;
Multi-Level Bill; Multi-Level Where Used; PBCI; Price Book Contents; Production; QUOI;
QUOT; Router/Traveler; SDAB; SDAL; Shortages by Order; Single-Level Configuration Bill of
Material Report; Summarized Bill; Supply Peg Detail; Where Used

Starting Item

The Starting field is used to request a list where the specified information appears first on the
list. Starting entries may consist of a partial entry and if the entry is not in the list, the next
highest entry appears first on the list. The Starting field can include one or more field
combinations, each with its own entry requirements.

Where Used: A/P 1099 Distribution; A/P Payment Application Detail; A/P Payment Void
Detail; A/P Received Item List; A/P Receiving Detail; A/R Payment Application Detail; APAH;
APDS; APEX; APID; APIE; APII; APIR; APIV; APPA; APPD; APPI; APPO; APTX; ARAH;
ARCD; AREX; ARIC; ARIH; ARPD; ARPH; ARSR; BAMT; Bank Payment Approval; BILI,
BILL; BKMT; Browse Setup (customer); Browse Setup (item); Browse Setup (vendor); CACF;
CCAN; CCAT; CCEX; CCMT; CIMT; CMCF; CMTA; CMTI; CNFA; COAN; COMI; COMT;
Contract Item Detail/Pricing; CORV; CPMT; CUID; CUIl; CUSI; CUST; FCMT; FCST; G/L
Account Group/No List; G/L Account No List; G/L Batch Detail; G/L Journal Entry List; G/L
Master Account Recap; G/L Org No List; G/L Org/Acct Group List; G/L Organization Group/No
List; G/L Report List; G/L Source Code List; GLAG; GLAV; GLBD; GLCA; GLCI; GLDQ;
GLEX; GLGQ; GLJD; GLJE; GLJI; GLJP; GLJR; GLMA; Global Extended Text Selection;
GLOS; GLRD; GLRL; GLSC; GLSI; GLSS; ITBI; ITCB; Item Master; Item Shortages; ITMB,;
ITMI; ITPB; ITPI; IVCO; IVIA; IVIE; IVII; IVRV; LMMT; Location Selection Setup; MCST;
MOAN; MOMI; MOMT; MORI; MORV; MPED; MPIT; MSMT; NMTA; OPSL; Orders on
Shipment; ORST; Packaging Detail; PASS; PBCI; Price Book Contents; PBMI; PBMT; PBUC;
PBUI; PCMT; PCST,; PICI; PICK; POAN; POAS; POCI; POCT; POMI; POMT; PORI; PORYV;
REDI; RTMT; RVED; SBOL; Selection Setup; Serial Number List; Serial Numbers Shipped;
SHIP; Shipments by Line Item; SHPI; SSII; STAD; SUND; SUNR; SUPD; SUPR; TEXT,
TXTA; VAT Summary (APSM Module); VATT; VEDI; VEID; VEND; VENI; Workcenter Master

UM

Unit of Measure identifies the standard unit for an item used in the manufacturing process.
Entry is up to 4 alphanumeric characters.
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Where Used:A/P PO/Inv Variance by Invoice; A/P Receiving Detail; APEX; APPI; APPV;
APUV; Available for Shipping Allocation Batch; AVII; AVIT; BILI; BILL; Bill of Material; Bill of
Material Detail; CCAT; CINV; CMLB; COBK; COCP; COMI; COMT; Contract Header Detail;
Contract Item Detail; Contract Item Detail/Pricing; CORV; Costed Bill Detail; CPMT; CSLB;
Custom Product Component Detail; Custom Product Detail; Customer Order; Customer Order
Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand Peg Detail;
Engineering; FCST; ICCR; IHIR; INVA; Inventory Allocation; INVR; IORD; IPPD; ITBI; ITCB,;
ITCI; Item + Quantity; Item Availability + Quantity; ltem Browse Detail; Item History; ltem Lot
Receipt; Iltem Lot Trace and Serialization Detail; tem Master; Item Master Detail; tem Master
Planning Detail; Item Responsibility Assigned Results; Item Shortages; ITHC; ITHR; ITMB;
ITMC; ITMI; ITPB; ITPI; IVPR; IVRR; JEST; Job Estimates and Performance Report; Lead
Times Assigned Results; LEXP; LHIS; Line Item Details + Item; LMSI; LMST; Location Index;
Lot Detail; Lot Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL,;
Manufacturing Order Line Item Detail; Manufacturing Order Receipt/Reverse; Material
Exposure; MBIL; MCST; MOMI; MOMT; MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-
Currency; Multi-Level Bill; Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order
Completion Status; Order Cost Variance Status; Order Detail; Order Line ltems; OVAR;
Packaging Detail; Packing List; Partner Iltem Detail; PBCI; Price Book Contents; PCST; PICI;
PICK; Picklist Detail; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POSR;
POVD; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List; Pricing
Maintenance + Test Order; Production; Purchase Order Line Item Detail; Purchase Order Line
Item Detail (CPMT); Purchase Order Line ltems; Purchase Order Receipt History; Purchased
Component Detail; QUOI; QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail;
Shipments by Line Item; Shipping Allocation Batch; Shipping Detail; Shortages by Order;
SHPL; Single-Level Configuration Bill of Material Report; SSII; SSIL; Standard Costs
Assigned Results; Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction
Detail; VDII; VDIT; VDSC; VEIT; Vendor/ltem Detail; VETI; VPFR; Where Used; WIPR;
Workcenter Master; WUSE
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Price Book Contents

Use the Price Book Contents screen to define the items contained in a price book and to maintain each
item's price information on the associated Quantity Breakpoints and Price Formulas window. Use Data
Import to add or delete groups of items from the price book.

Two versions of this screen are available: one for maintenance and one for inquiry use only. The
information displayed is the same, only the ability to change the information changes depending on the
screen you access.

* F9 from the PBMT (Price Book Master) screen allows you to view and update price books.
«  F9 from the PBMI (Price Book Master Inquiry) screen only allows you to view this information.
See "Entry and Inquiry Screens" under "Screen Types" in the Using Fourth Shift section of the Fourth
Shift Basics manual for more information.
Transportation Shortcuts

You can use shortcut keys or transport buttons to go to the following related screens.

Destination Shortcut Key(s)
Returns to PBMT/PBMI (Price Book Master) F8
ltem Quantity Breakpoint F9
CUPB/CUPI (Customers Using Price Book) F10

Browse Windows

You can open browse windows by choosing Browse/Detail from the Tools menu in the following
fields:

Browse From Fields

Price Book Name Browse Price Book Name

For more information, see "Selecting from a Browse List" in the Fourth Shift Basics manual.

Reports

Price Book Contents (Iltem, UM and Descriptions only)
Lists items contained in a price book showing only the items.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

Report Template
For more information on report templates, see “Reporting for SQL Server Systems” in the System
help.
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Price Book Contents--Formulas for Unit Price & Expedite Fees
Lists items contained in a price book showing formulas.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

Report Template
For more information on report templates, see “Reporting for SQL Server Systems” in the System
help.

Price Book Contents--Quantity Breaks & Prices
Lists items contained in a price book showing the quantity breaks and prices.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

Report Template
For more information on report templates, see “Reporting for SQL Server Systems” in the System
help.

Screen Reference

Using the Default Breakpoint Settings Window

The Default Breakpoint Settings window is opened from by pressing F8 at the PBMT (Price Book
Master) screen. The Default Breakpoint Settings window is used to view and maintain the default
price information used when adding an item to a price book. You can define an unlimited number
of quantity breakpoints and specify the unit price formula and the expedite fee formula for each
quantity breakpoint.

There is always one quantity breakpoint. Before establishing your own quantity breakpoints, a
quantity breakpoint of 1 through 9999999999 is listed. As you add, change and delete quantity
breakpoints, the From field reflects the changes. The last Thru field remains at 9999999999.

Using the Quantity Breakpoints and Price Formulas Window

The Quantity Breakpoints and Price Formulas window is used to view and maintain the price
information for an item in a price book. You can define an unlimited number of quantity breakpoints
and specify the unit price and expedite fee formula for each quantity breakpoint.

There is always one quantity breakpoint. If default quantity breakpoint settings were on when the
item was added to the price book, the Quantity Breakpoints and Price Formulas window lists
quantity breakpoints based on the default settings. If default quantity breakpoint settings were not
used during item addition, a quantity breakpoint of 1 through 9999999999 is listed. As you add,
change and delete quantity breakpoints, the From field reflects the changes. The last Thru field
remains at 9999999999.

Press F9 from an item line to open the window.
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Fields

Cust Id
Customer ldentification is the identification number assigned to a customer. Entry is any
alphanumeric combination of up to 13 characters.

Cust Item
Customer Item is the identification assigned to the item by the customer. Entry is any
alphanumeric combination of up to 30 characters.

Conv

Customer Item Conversion is used to calculate the order quantity based on the ratio
between the customer’s unit of measure and the stocking unit of measure. Entry is numbers
only. Decimal places are allowed.

Description (Customer Item)

Customer Item Description is the description assigned to the item by the customer. Entry is
any alphanumeric combination of up to 70 characters.

Description (Price Book)

Price Book Description identifies the price book in terms of its characteristics. When space is
limited, a partial description is displayed.

Where Used: Available Pricing; CUPB; CUPI; PBII; PBMI; PBMT; Price Book Assignment;
Price Book Usage, Price Book Contents

Function

Function codes are four-character abbreviations for screen names. Each screen has a unique
code used for identification and transportation. For example, ITMB identifies the Item Master
screen. Entry is 4 alphanumeric characters.

Where Used: screens and reports

Price Book In Effectivity
Price Book In Effectivity Date is the date the price book becomes effective.

Where Used: Available Pricing; CUPB; CUPI; PBII; PBMI; PBMT; Price Book Contents

Price Book Name

Price Book Name is the unique identifier for a price book. Entry is any alphanumeric
combination of up to 15 characters.

Where Used: Available Pricing; CUPB; CUPI; PBII; PBMI; PBMT; Price Book Assignment;
Price Book Usage; Price Book Contents
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Price Book Out Effectivity
Price Book Out Effectivity Date is the last date that the price book is effective.
Where Used: Available Pricing; CUPB; CUPI; Price Book Contents; PBIl; PBMI; PBMT

Starting Cust Item

The Starting field is used to request a list where the specified information appears first on the
list. Starting entries may consist of a partial entry and if the entry is not in the list, the next
highest entry appears first on the list. The Starting field can include one or more field
combinations, each with its own entry requirements.

Customer Item UM

Customer Item Unit of Measure identifies the standard unit of measure assigned to the item
by the customer. Entry is up to 4 letters.

Where Used: CIMT; Customer Item + General; Customer Order Receipt/Reverse; Line Item
Details + Customer Item; MPIT; Partner ltem Detail; Pricing Maintenance + Test Order;
Shipments by Line Item; Standard Product Detail
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Price Book Usage by Customer

Use the Price Book Usage by Customer screen to view all customers in the Customer Master and the
number of price books used by each customer. Open the Price Book Usage window to view and maintain
price books used by a selected customer.

Data Import is available to connect price books to customers. Refer to the Data Import manual for more
information.

You can access the Price Book Usage by Customer screen:
* ALT+F8 from CUID (Customer Master Inquiry)
e ALT+F8 from CUST (Customer Master)

Reports

A standard report is not generated for this screen. Use the Print Screen key or any screen capture
program to create an image of the screen.

Fields

Price Book Name

Price Book Name is the unique identifier for a price book. Entry is any alphanumeric
combination of up to 15 characters.

Description

Price Book Description identifies the price book in terms of its characteristics. When space is
limited, a partial description is displayed.

Customer In Effectivity

Customer In Effectivity date is the date the price book becomes effective for this customer.
Customer Out Effectivity

Customer Out Effectivity date is the last date the price book is effective for this customer.
Customer Pref

Customer Preference identifies the price book-customer relationship. One customer can be
associated with up to 36 price books, each having a unique Customer Preference character.
You can enter the Customer Preference identifier in the ST field on a COMT line item prior to
opening the Available Pricing window in order to display the preferred price book when the
window is opened. Entry is 1 alphanumeric character A-Z or 0-9.

Customer Sp

Customer Special designates that the price book used by the customer is a special
promotion. The price book is flagged as special on the Available Pricing window. Entry is 1
alphanumeric character.
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Pb Typ

Price Book Type indicates which type of items are included in the price book.

Q = Customer items
C = Catalog items
| = ltem Master items
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CPBK - Copy Price Book

The Copy Price Book screen provides the capability of duplicating an existing price book. Use this feature
to minimize data entry when you have price books containing similar items. When copying items into the
target price book, price information for each item can be based on the source price book or on default
breakpoint settings of the target price book.

Important:

- If the To price book already has default price breaks defined, then all items of the
From price book will use the default price breaks of the To price book at the item level

also.

- Ifthe To price book does not have any default price breaks defined, then all items of
the From price book will retain the From price breaks.

Transportation Shortcuts

You can use shortcut keys or transport buttons to go to the following related screens.

Destination Shortcut Key(s)
PBMT (Price Book Master) F8
CUPB (Customers Using Price Book) F9
PBII (Price Book Usage By Item) F10

Browse Windows

You can open browse windows by choosing Browse/Detail from the Tools menu in the following

fields:
Browse From Fields
Price Book Name Browse Copy from Price Book,
Copy to Price Book

For more information, see "Selecting from a Browse List" in the Fourth Shift Basics manual.

Reports

A standard report is not generated for this screen. Use the Print Screen key or any screen capture
program to create an image of the screen.

Screen Reference

Format

The Copy Price Book screen has the following entry fields.
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+ Copy From Price Book. Use this field to specify the name of the source price book you want
to copy or use as the pattern.

+ Copy To Price Book. Use this field to specify the name of the target price book to which you
want the source price book copied. The target price book may already contain items. Once
copied, you can add to the contents of the target price book.

Using the Default Breakpoint Settings Window

The Default Breakpoint Settings window is opened from the PBMT (Price Book Master) screen
and is used to view and maintain the default price information used when adding an item to a price
book. You can define an unlimited number of quantity breakpoints and specify the unit price
formula and the expedite fee formula for each quantity breakpoint. The breakpoint settings are
defined for each price book.

There is always one quantity breakpoint. Before establishing your own quantity breakpoints, a
quantity breakpoint of 1 through 9999999999 is listed. As you add, change and delete quantity
breakpoints, the From field reflects the changes. The last Thru field remains at 9999999999.

Go to PBMT (Price Book Master), press F8 to open Price Book Breakpoints to establish the
settings for the “to Price Book.”
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CUPB - Customers Using Price Book

The Customers Using Price Book screen is used to define the customers using a price book and the
related usage effectivity dates. You can also specify a price book usage preference and special promotion
flag for each customer using the price book, which selects available price books on the COMT screen. Use
the Data Import feature to add or delete groups of customers using the price book.

Two versions of this screen are available: one for maintenance and one for inquiry use only. The
information displayed is the same, only the ability to change the information changes depending on the
screen you access.

* The CUPB (Customers Using Price Book) screen allows you to view and update price book
information.

+ The CUPI (Customers Using Price Book Inquiry) screen only allows you to view this
information.

See "Entry and Inquiry Screens" under "Screen Types" in the Using Fourth Shift section of the Fourth
Shift Basics manual for more information.
Transportation Shortcuts

You can use shortcut keys or transport buttons to go to the following related screens.

Destination Shortcut Key(s)
PBMT/PBMI (Price Book Master) F8
PBII (Price Book Usage by Item) F9
CPBK (Copy Price Book F10

Browse Windows

You can open browse windows by choosing Browse/Detail from the Tools menu in the following

fields:
Browse From Fields
Customer Browse CustId
Price Book Name Browse Price Book Name

For more information, see "Selecting from a Browse List" in the Fourth Shift Basics manual.

Reports

Customers Using Price Book

Lists all customers using a price book. Use the Effectivity window to select and print the report for
active, pending, expired or all customers.
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Access Method
To generate the report, choose Print or Print Preview from the File menu. The Report screen
appears before the report is generated to allow you to select a range of data for the report.

Report Template
For more information on report templates, see "Reporting for SQL Server Systems" in the System
Help.

The default template for this report is /APBM/ApbCupb.rdl.

Fields
Cust Id

Customer Identification is the identification number assigned to a customer. Entry is any
alphanumeric combination of up to 13 characters.

Where Used: Advance Ship Notice Carrier Detail; Advance Ship Notice Shipment Detail;
ARAH; ARCD; ARCJ; ARCP; ARCR; AREX; ARIC; ARIH; ARIP; ARIR; ARPD; ARPH; ARRJ;
ARSC; ARSR; ARST; ARTB; ARTX; Available Customer Shipments; Available for Shipping
Allocation Batch; Browse Setup (customer); Browse Setup (order); CIMT; CINV; COAN;
COBK; COCD; COCP; COMI; COMT; CORV; COYE; CPMT; CUID; CUII; Cumulative Detail;
CUPB; CUPI; CUSI; CUST; Custom Product Component Detail; Custom Product Detail;
Customer; Customer Browse; Customer Browse Detail; Customer Financial Detail; Customer
Invoice List; Customer Item + General; Customer Name/Address Detail; Customer Order;
Customer Order + Order Header; Customer Order Header Detail; Customer Order Receipt/
Reverse; Customer Payment List; Demand Peg Detail; EDIX; EXRU; G/L Distribution (ARSM
Module); GASN; Inbound Conversion Detail; Inventory Adjustment Application; Invoice
Header Detail; Invoice Line Item Detail; IORD; IVCO; IVIA; IVIE; IVII; IVPP; IVPR; IVRR;
IVRV; JEST; Job Estimates and Performance Report; Lot Trace Issue Detail; Lot Trace
Receipt Detail; Material Shortages Detail; MOAN; MPED; MPIT; MSMT; OPSL; Order Browse;
Order Detail; ORST; Outbound Conversion Detail; Partner ltem Detail; PCMT; PICI; PICK;
Picklist Detail; Pricing Maintenance + ltems/Customers; Pricing Maintenance + Test Order;
SBOL; Serial Number List; SHIP; Ship to Browse; Ship to Browse Detail; Shipment Allocation
Detail; Shipment Allocation List; Shipping Allocation Batch; SHPI; SHPL; STAD; Standard
Product Detail; Supply Peg Detail; Transaction Detail

Customer In Effectivity
Customer In Effectivity date is the date the price book becomes effective for this customer.
Where Used: CUPB; CUPI; Price Book Usage

Customer Out Effectivity

Customer Out Effectivity date is the last date the price book is effective for this customer.
Where Used: CUPB; CUPI; Price Book Usage

Customer Pref

Customer Preference identifies the price book-customer relationship. One customer can be
associated with up to 36 price books, each having a unique Customer Preference character.
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You can enter the Customer Preference identifier in the ST field on a COMT line item prior to
opening the Available Pricing window in order to display the preferred price book when the
window is opened. Entry is 1 alphanumeric character A-Z or 0-9.

Where Used: CUPB; CUPI; Price Book Usage

Customer Sp

Customer Special designates that the price book used by the customer is a special
promotion. The price book is flagged as special on the Available Pricing window. Entry is 1
alphanumeric character.

Where Used: Available Pricing; CUPB; CUPI; Price Book Usage

Description

Price Book Description identifies the price book in terms of its characteristics. When space is
limited, a partial description is displayed.

Where Used: Available Pricing; CUPB; CUPI; PBCI; Price Book Contents; PBIl; PBMI;
PBMT; Price Book Assignment; Price Book Usage

Function

Function codes are four-character abbreviations for screen names. Each screen has a unique
code used for identification and transportation. For example, ITMB identifies the Item Master
screen. Entry is 4 alphanumeric characters.

Where Used: screens and reports

Where Used: CPBK; CUPB; CUPI; PBCI; Price Book Contents; PBMI; PBMT;

Name

Customer Name is the name of a customer. Entry is any alphanumeric combination of up to
60 characters.

Where Used: ARAH; ARCD; ARCJ; ARCR; AREX; ARIC; ARIH; ARIP; ARIR; ARPD;
ARPH; ARRJ; ARSC; ARSR; ARTB; ARTX; Available Customer Shipments; Browse Setup
(customer); Browse Setup (order); CIMT; COBK; COCD; COMI; COMT; CORV; COYE;
CPMT; CUID; CUIl; CUPB; CUPI; CUSI; CUST; Custom Product Component Detail; Custom
Product Detail; Customer; Customer + Address; Customer + General; Customer Browse;
Customer Browse Detail; Customer Financial Detail; Customer Invoice List; Customer ltem +
General; Customer Name/Address Detail; Customer Order; Customer Order Header Detail;
Customer Order Receipt/Reverse; Customer Payment List; EDIX; EXRU; G/L Distribution
(ARSM Module); IVCO; IVIA; IVPP; JEST; Job Estimates and Performance Report; Lot Trace
Issue Detail; Lot Trace Receipt Detail; OPSL; Order Browse; Order Detail; ORST; PICI; PICK;
Picklist Detail; Pricing Maintenance + Test Order; SBOL; Serial Number List; SHIP; Ship to
Browse Detail; Shipment Allocation List; Shipping Detail; SHPI; SHPL; STAD; Standard
Product Detail

Price Book In Effectivity

Price Book In Effectivity Date is the date the price book becomes effective.

Advanced Price Book 37



Fourth Shift Release 8.00 CUPB - Customers Using Price Book

Where Used: Available Pricing; CUPB; CUPI; PBCI; Price Book Contents; PBIl; PBMI;
PBMT

Price Book Name

Price Book Name is the unique identifier for a price book. Entry is any alphanumeric
combination of up to 15 characters.

Where Used: Available Pricing; CUPB; CUPI; PBCI; Price Book Contents; PBIl; PBMI;
PBMT; Price Book Assignment; Price Book Usage

Price Book Out Effectivity
Price Book Out Effectivity Date is the last date that the price book is effective.

Where Used: Available Pricing; CUPB; CUPI; PBCI; Price Book Contents; PBIl; PBMI;
PBMT

Advanced Price Book

38



Fourth Shift Release 8.00 PBCF — Price Book Configuration

PBCF — Price Book Configuration

The Price Book Configuration screen defines the global settings for all price books. It is used to determine
when a price book will display as well as preference usage and effectivity date basis.

Transportation Shortcuts

You can use shortcut keys or transport buttons to go to the following related screens.

Destination Shortcut Key(s)
PBMT/PBMI (Price Book Master) F8
PBII (Price Book Usage by Item) F9
CPBK (Copy Price Book F10

Browse Windows

You can open browse windows by choosing Browse/Detail from the Tools menu in the following

fields:
Browse From Fields
Customer Browse Custid
Price Book Name Browse Price Book Name

For more information, see "Selecting from a Browse List" in the Fourth Shift Basics manual.

Fields

Number Of Decimal Places For Prices

Number of Decimal Places for Prices indicates the number of decimal places to be used
when displaying calculated prices on inquiry screens and the Available Pricing and Quantity
Breaks And Expedite Fees windows. Values are rounded to the number of decimal positions
specified. Entry options are:

0 = zero positions

1 = one positions

2 = two positions

3 = three positions

4 = four positions

5 = five positions

6 = six positions

7 = seven positions

8 = eight positions
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Pending Price Books Displayable Within

Pending Price Books Displayable Within determines the number of days before the price
book becomes effective and is displayed in the available price books when selecting prices for
order lines.

Pending Price Books Selectable Within

Pending Price Books Selectable Within determines the number of days before the price
book can be selected from the available price books.

Expedite Fees May be De-Selected by User

Allow Override of Expedite Fees indicates if the expedite fee may be removed when the
price is selected for use.

N = No.
Y =Yes.
Price May Be Selected From Any Quantity Break

Allow Selection of Any Price Break indicates whether order entry personnel can select from
any quantity break level, rather than just the most appropriate level, based on order quantity.

N = No.
Y =Yes.
Match Price Book Preference To ‘ST’ Field On The COMT Screen

Apply Price Book Preference to CO Demand Source determines if the customer price
should default to an order line when the Source Type (ST) field on the customer order (COMT
screen) matches the Source Type (ST) setting for the price book line.

N = No.
Y =Yes.
Base Price Book Effectivity On Current, Ship Or Delivery Date
Price Book Effectivity Date Code indicates the basis for price book effectivity. Options are:

C = Current date is used for the price book effectivity date.

S = Ship date is used for the price book effectivity date.

D = Delivery date is used for the price book effectivity date.
Disable Customer In-Effectivity Date

Disable Customer In Effectivity Date indicates whether to ignore the in effectivity date
assigned to a customer/price book relationship. Options are:

Y = Yes.
N = No.

Disable Customer Out-Effectivity Date

Disable Customer Out Effectivity Date indicates whether to ignore the out effectivity date
assigned to a customer/price book relationship. Options are:

Y = Yes.
N = No.
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PBIl — Price Book Usage by Item

The Price Book Usage by Item screen identifies price books and price book effectivity dates for the
specified item. Price information can be accessed by opening the associated Quantity Breakpoints and
Price Formulas window.

Transportation Shortcuts

You can use shortcut keys or transport buttons to go to the following related screens.

Destination Shortcut Key(s)
ltem Quantity Breakpoints F8
PBMI (Price Book Master Inquiry) F9
CUPI (Customers Using Price Book Inquiry) F10

Browse Windows

You can open browse windows by choosing Browse/Detail from the Tools menu in the following
fields:

Browse From Fields

Item Browse Item

For more information, see "Selecting from a Browse List" in the Fourth Shift Basics manual.

Reports

Price Book Usage by Item--Formulas for Unit Price & Expedite Fees
Lists price books for an item showing unit price formulas and expedite fees.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

Report Template
For more information on report templates, see “Reporting for SQL Server Systems” in the System
Help.
Price Book Usage by Item--Pricebook & Descriptions Only
Lists price books for an item by price book and description only.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

Report Template

Advanced Price Book 41



Fourth Shift Release 8.00 PBII — Price Book Usage by Item

For more information on report templates, see “Reporting for SQL Server Systems” in the System
Help.

Price Book Usage by Item--Quantity Breaks & Prices
Lists price books for an item showing quantity breaks and prices.

Access Method
To generate the report, choose Print from the File menu. For more information on reporting in
general, see "Printing and Reporting" in the Fourth Shift Basics manual.

Report Template
For more information on report templates, see “Reporting for SQL Server Systems” in the System
Help.

Screen Reference

Using the Quantity Breakpoints and Price Formulas Window

The Quantity Breakpoints and Price Formulas window is used to view and maintain the price
information for an item in a price book. You can define an unlimited number of quantity breakpoints
and specify the unit price and expedite fee formula for each quantity breakpoint.

There is always one quantity breakpoint. If default quantity breakpoint settings were on when the
item was added to the price book, the Quantity Breakpoints and Price Formulas window lists
quantity breakpoints based on the default settings. If default quantity breakpoint settings were not
used during item addition, a quantity breakpoint of 1 through 9999999999 is listed. As you add,
change and delete quantity breakpoints, the From field reflects the changes. The last Thru field
remains at 9999999999.

Fields

Description

Item Description identifies the item in terms of its characteristics. When space is limited, a
partial description is displayed. Entry is any alphanumeric combination of up to 70 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; APPI; APPV;
Available Pricing; AVII; AVIT; BILI; BILL; Bill of Material; Bill of Material Detail; Browse Setup
(item); Capacity Planning; CCAN; CCAT; CMLB; COBK; COCP; COMP; Comparison Bill;
Comparison of Summarized Bills; Contract Item Detail; Contract Item Detail/Pricing; CORV;
Cost Estimate by Lot Size; Costed Bill Detail; CSLB; Custom Product Component Detail;
Customer Item + General; Customer Order; Customer Order Receipt/Reverse; CWIP;
Demand Peg Detail; Dispatch List; Engineering; FCST; ICCR; IHIR; INVA; Inventory
Allocation; Inventory History List; Inventory Transaction History Report; INVR; IORD; IPPD;
ISVI; ITBI; ITCB; ITCI; Item + Alternates; ltem + Quantity; Item Availability; ltem Availability +
Quantity; Iltem Browse; Item Browse Detail; Iltem History; Item Lot Trace and Serialization
Detail; Item Master; Item Master Detail; Item Master Planning Detail; Iltem Responsibility
Assigned Results; ITMB; ITMC; ITMI; ITPB; ITPI; Job Estimates and Performance Report;
Lead Time; Lead Time Analysis; Lead Times Assigned Results; LEXP; Line Iltem Details +
Item; LMSI; LMST; Location Index; Lot Detail; Lot Inventory Transaction History Report; Lot
Trace; Lot Trace Issue Detail; Lot Trace Receipt Detail; LOTR; LVAL; Manufacturing Order
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Line Item Detail; Manufacturing Order Receipt/Reverse; Material Exposure; MBIL; MCST;
MOMI; MOMT; MORI; MORV; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill;
Multi-Level Where Used; MUSE; Open Order Detail; OPSL; Order Completion Status; Order
Cost Variance Status; Order Detail; Order Line Items; OVAR; Package Content; Packaging
Detail; Partner Item Detail; PBCI; Price Book Contents; PBII; PICI; PICK; Picklist Detail;
POAN; POAS; POCI; POCR; POCT; POMI; POMT; PORI; PORR; PORV; POYE; Production;
Purchase Order Line Item Detail; Purchase Order Line ltem Detail (CPMT); Purchase Order
Line Items; Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI;
QUOT; Router/Traveler; SDAB; SDAL; Shipment Allocation Detail; Shipments by Line ltem;
Shipping Detail; Shortages by Order; SHPL; Single-Level Configuration Bill of Material Report;
SSII; SSIL; Standard Costs Assigned Results; Standard Product Detail; Summarized Bill;
Supply Peg Detail; Transaction Detail; VDII; VDIT; VDSC; VITI; Where Used; WIPR; WUSE

Description

Price Book Description identifies the price book in terms of its characteristics. When space is
limited, a partial description is displayed.

Where Used: Available Pricing; CUPB; CUPI; PBCI; Price Book Contents; PBIl; PBMI;
PBMT; Price Book Assignment; Price Book Usage

Function

Function codes are four-character abbreviations for screen names. Each screen has a unique
code used for identification and transportation. For example, ITMB identifies the Item Master
screen. Entry is 4 alphanumeric characters.

Where Used: screens and reports

Item

Item is the unique identifier for a part, whether it be a piece part, tool, raw material, an
assembly or finished product. All items are set up using the ITMB screen. Within a product
structure, an item can be a component as well as a parent. Entry is any alphanumeric
combination of up to 30 characters.

Where Used: A/P Received Item List; ABCR; Advance Ship Notice Line; Allowance/Charge
Detail (Detail); APPI; APPV; AUDT; Available for Shipping Allocation Batch; AVII; AVIT; Bill of
Material Accuracy Results; Browse Setup (item); Capacity Planning; CBIL; CCAN; CCAT;
CIMT; CINV; COAN; COBK; COCD; COMI; COMP; Comparison Bill; Comparison of
Summarized Bills; COMT; Contract ltem Detail; Contract ltem Detail/Pricing; Contract
Summary; CORV; CSTU; Cumulative Detail; Customer Item + General; Customer Order;
Customer Order Line Price Adjustment; Customer Order Receipt/Reverse; CWIP; Demand
Peg Detail; Engineering; FCST; GASN; ICCR; IHIR; IMTR; INVA; Inventory Adjustment
Application; Inventory Allocation; Inventory History List; Inventory Transaction History Report;
INVR; IORD; IPPD; ISVI; ITBI; ITCB; ITCI; ltem + Quantity; ltem Availability; Item Availability +
Quantity; Item Browse; Item Browse Detail; Item History; Item Lot Receipt; ltem Lot Trace and
Serialization Detail; Item Master; ltem Master Detail; Item Master Planning Detail; Iltem
Responsibility Assigned Results; ltem Shortages; ITHC; ITHR; ITMB; ITMC; ITMI; ITPB; ITPI;
Lead Times Assigned Results; LEXP; LHIS; Line ltem Details + ltem; LMSI; LMST; Lot Detail;
Lot Inventory Transaction History Report; Lot Selection; Lot Trace; Lot Trace Issue Detail; Lot
Trace Receipt Detail; LOTR; LVAL; Manufacturing Order Line Item Detail; Manufacturing
Order Receipt/Reverse; Material Shortages Detail; MCST; MOAN; MOFR; MOMI; MOMT;
MORI; MORV; MPIT; MPSR; MPSS; MSMT; Multi-Level Bill; Multi-Level Costed Bill; Multi-
Level Where Used; MUSE; Open Order Detail; Order Completion Status; Order Cost Variance
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Status; Order Detail; OVAR; Package Content; Packaging Detail; Packing List; Partner ltem
Detail; PBCI; Price Book Contents; PBII; PICI; PICK; Picklist Detail; POCI; POCR; POCT;
PORI; PORV; POYE; Pricing Maintenance + Action Detail; Pricing Maintenance + Action List;
Pricing Maintenance + ltems/Customers; Pricing Maintenance + Test Order; Production;
Purchase Order Receipt History; Purchased Component Detail; QSRC; QUOI; QUOT; Router/
Traveler; Schedule Board; SDAB; SDAL; Selection Setup; Serial Number List; Serial Numbers
Shipped; SHIP; Shipment Allocation Detail; Shipment Allocation List; Shipments by Line Item;
Shipping Allocation Batch; Shortages by Order; SHPL; SSII; SSIL; Standard Costs Assigned
Results; Standard Product Detail; Summarized Bill; Supply Peg Detail; Transaction Detail;
VDII; VDIT; VDSC; VEIT; Vendor/ltem Detail; VETI; VITI; VPFR; WIPL; WIPR; WIPS; WUSE

Price Book In Effectivity
Price Book In Effectivity Date is the date the price book becomes effective.

Where Used: Available Pricing; CUPB; CUPI; PBCI; Price Book Contents; PBIl; PBMI;
PBMT

Price Book Name

Price Book Name is the unique identifier for a price book. Entry is any alphanumeric
combination of up to 15 characters.

Where Used: Available Pricing; CUPB; CUPI; PBCI; Price Book Contents; PBIl; PBMI;
PBMT; Price Book Assignment; Price Book Usage

Price Book Out Effectivity
Price Book Out Effectivity Date is the last date that the price book is effective.

Where Used: Available Pricing; CUPB; CUPI; PBCI; Price Book Contents; PBIl; PBMI;
PBMT

Quantity Breakpoints and Price Formulas Fields

Expedite Fee

Expedite Fee is the amount added to the order's unit price and is calculated using the
Expedite Fee Formula.

Expedite Fee Formula

Expedite Fee Formula consists of Price Basis and the related Price/Multiple, as shown in
the following possible combinations. Whenever the number of shop days between the current
date and the shipment date is less than or equal to the Lead Time (transportation lead time
days), the Expedite Fees can be incurred.

Price Basis Price/Multiple

A = Absolute Absolute price entered as UNIT PRICE

P = List Price Multiple of UNIT PRICE

C = Std Cost Multiple of total roll cost, Cost Type=0
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Price Basis Price/Multiple

0 = Std Cost Multiple of total roll cost, Cost Type=0

1 = Cost Data Multiple of total roll cost, Cost Type=1

3 = Cost Data Multiple of total roll cost, Cost Type=3

4 = Cost Data Multiple of total roll cost, Cost Type=4

5 = Cost Data Multiple of total roll cost, Cost Type=5

6 = Cost Data Multiple of total roll cost, Cost Type=6

7 = Cost Data Multiple of total roll cost, Cost Type=7

8 = Cost Data Multiple of total roll cost, Cost Type=8

9 = Cost Data Multiple of total roll cost, Cost Type=9

Entry in the Price/Multiple field can be any numeric value between 0 and 10000000 with up to
4 decimal places.

From Quantity Breakpoint

From Quantity Breakpoint indicates the lowest value in the breakpoint range and is
automatically assigned by the system based on the Thru Quantity Breakpoint value of the
previous breakpoint range.

Through Quantity Breakpoint

Thru Quantity Breakpoint indicates the highest value in the breakpoint range. Entry is up to
10 numbers.

Unit Price

Unit Price is the price per unit of the item being ordered. Entry up to 16 numbers. Decimals
are allowed.

Unit Price Formula

Unit Price Formula consists of a Price Basis and the related Price/Multiple, as shown in the
following possible combinations.

Price Basis Price/Multiple

A = Absolute Absolute price entered as UNIT PRICE

P = List Price Multiple of UNIT PRICE

C = Std Cost Multiple of total roll cost, Cost Type=0

0 = Std Cost Multiple of total roll cost, Cost Type=0

1 = Cost Data Multiple of total roll cost, Cost Type=1
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Price Basis

Price/Multiple

3 = Cost Data

Multiple of total roll cost, Cost Type=3

4 = Cost Data

Multiple of total roll cost, Cost Type=4

5 = Cost Data

Multiple of total roll cost, Cost Type=5

6 = Cost Data

Multiple of total roll cost, Cost Type=6

7 = Cost Data

Multiple of total roll cost, Cost Type=7

8 = Cost Data

Multiple of total roll cost, Cost Type=8

9 = Cost Data

Multiple of total roll cost, Cost Type=9

Entry in the Price/Multiple field can be any numeric value between 0 and 10000000 with up to

4 decimal
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